Microsoft Word 2010 Basics I - Navigating and Formatting
This workshop assumes no experience with Microsoft Word. In this workshop we will learn keyboard and mouse shortcuts to quickly move through documents and to format the text. Topics include understanding the end of page character; copy and paste; undo and redo; mouse shortcuts; formatting fonts; copying formats; character spacing; find and replace for text, formats and special characters.

Navigating with the Keyboard ........................................................................................................ 1
  Horizontal Arrow Keys ......................................................................................................................... 1
  Vertical Arrow Keys ............................................................................................................................... 1
  Home Key ............................................................................................................................................. 1
  End Key ................................................................................................................................................ 1
  Backspace and Delete ............................................................................................................................ 1
  PageUp and PageDown Keys .................................................................................................................. 2

Navigating with the Mouse .................................................................................................................. 2
  Scroll Wheel ......................................................................................................................................... 2
  Clicking Inside Text ............................................................................................................................... 2
  Clicking Outside Text ............................................................................................................................... 2
  Moving and Duplicating with the Mouse ............................................................................................... 3

Navigating with the Scroll Bar ............................................................................................................. 3
  Scroll Bar .............................................................................................................................................. 3
  Browse by Buttons .................................................................................................................................. 3
  Zoom Slider ......................................................................................................................................... 4

Shortcut Keys ........................................................................................................................................ 4
  Cut, Copy and Paste ............................................................................................................................... 4
  File Management .................................................................................................................................. 4
  Resizing ................................................................................................................................................. 4
  Formatting Text ....................................................................................................................................... 4
  Alphabetical List .................................................................................................................................... 5

Opening a File .......................................................................................................................................... 6
  Open Toolbar .......................................................................................................................................... 6
Microsoft Word: Basics I - Navigating and Formatting

1.5 hours

Saving........................................................................................................................... 7
Save As...................................................................................................................... 7
Closing a Document................................................................................................. 8
Undo, Redo and Repeat........................................................................................... 8
Cut, Copy and Paste................................................................................................. 9
Format Font ............................................................................................................... 10
  Font Dialog Box...................................................................................................... 11
  Effects .................................................................................................................... 11
  Set as Default......................................................................................................... 11
  Text Effects........................................................................................................... 12
  Advanced ............................................................................................................... 13
  OpenType Features .............................................................................................. 13
Find and Replace....................................................................................................... 14
  "More" Search Options ...................................................................................... 15
  Replacing Formats .............................................................................................. 16
  Special Characters .............................................................................................. 17
Class Exercise ......................................................................................................... 18

Pandora Rose Cowart
Education/Training Specialist
UF Health IT Training

C3-013 Communicore (352) 273-5051
PO Box 100152 prcowart@ufl.edu
Gainesville, FL 32610-0152 http://training.health.ufl.edu

Updated 6/12/2016
Navigating with the Keyboard

**Horizontal Arrow Keys**
The ← (left arrow) on the keyboard will move your cursor left one character and the → (right arrow) on the keyboard will move your cursor right one character.
- If you hold down the SHIFT key while moving your ← or → you will select text as you move.
- If you hold down the CTRL (control) key while moving your ← or → you will move word by word.
  - If you hold down the SHIFT and CTRL key while moving your ← or → you will select word by word.

**Vertical Arrow Keys**
The ↑ (up arrow) and the ↓ (down arrow) on the keyboard move your cursor up and down respectively, line by line.
- If you hold down the SHIFT key while moving your ↑ or ↓ you will select text as you move.
- If you hold down the CTRL (control) key while moving your ↑ or ↓ you will move paragraph by paragraph. (Every Enter (¶) is considered a paragraph).
  - If you hold down the SHIFT and CTRL key while moving your ↑ or ↓ you will select paragraph by paragraph.

**Home Key**
The HOME key takes to you the beginning of the current line.
- If you hold down the SHIFT key when you press the HOME key you will select text from where the cursor is blinking to the beginning of the line.
- If you hold down the CTRL (control) key when you press the HOME key you will move to the beginning of the document.
  - If you hold down the SHIFT and CTRL key when you press the HOME key you will select from where the cursor is blinking to the beginning of the document.

**End Key**
The END key takes you to the end of the line.
- If you hold down the SHIFT key when you press the END key you will select text from where the cursor is blinking to the end of the line.
- If you hold down the CTRL key when you press the END key you will move to the end of the document.
  - If you hold down the SHIFT and CTRL key when you press the END key you will select from where the cursor is blinking to the end of the document.

**Backspace and Delete**
The Backspace key erases text backwards, from right to left, backing over the text. The Delete key erases text forwards from left to right erasing text after the cursor. Delete is more universally used throughout windows to remove objects such as images, table cell contents, and files. Backspace is used fundamentally for text only.
- If you hold down the CTRL key when you press Backspace or Delete, it will erase word by word.
PageUp and PageDown Keys
The PageUp key will move your cursor up one screenful, toward the top of the document. The PageDown key will move you down one screenful, toward the bottom of the document.
- If you hold down the SHIFT key when you press the PageUp/PageDown key you will select text from where the cursor is blinking to the screenful above or below (respectively) of where your cursor were blinking.
- If you hold down the CTRL key when you press the PageUp/PageDown key your cursor will move to what your browse object buttons are set to, by default this is to the top of the previous or next page (respectively). However, if you have used the Find/Replace/Goto features in Word, it will reset these buttons (and this shortcut key) to search; you will know the buttons have been changed, because they will be blue.
- To reset the buttons to Browse by Page, click on the middle circle button and choose the blank sheet of paper.

Navigating with the Mouse

Scroll Wheel
- On most computer mice you will find a middle scroll wheel. When your mouse is hovering over the ribbon at the top of the window, Word will scroll through the different tabs. When your mouse is hovering over the document, it will scroll through the pages. As with the Scroll Bar, this will only move the pages, not the cursor.
- If you hold down the CTRL key while using the scroll wheel, Word will zoom in and out.

Clicking Inside Text
- Click once (Single Click) - Word will move the cursor to where you clicked.
  - If you hold the SHIFT key when you click, it will select the text from where the cursor was blinking to where you clicked.
  - If you hold the CTRL key when you click, it will select the sentence you clicked on. This will not work if there is a current selection. Once a selection is made, you can use the CTRL key to add to the selection.
- Click twice (Double-click) - it will select the word.
- Click three times (Triple Click) - it will select the paragraph.
- Click and Drag (don’t let go of the mouse) it will select text, from where you first clicked to where you let go of the mouse button. Click and Drag a selection, will move the text to where you let go.

Clicking Outside Text
If you move your mouse out into the left margin so that the mouse cursor turns into a white arrow that points back at the text and you:
- click once (Single Click) - it will select the line
- click twice (Double-click) - it will select the paragraph
- click three times (Triple Click) - it will select the whole document (Same Ctrl-A)
Moving and Duplicating with the Mouse

- If you put your mouse over selected (highlighted) text, you will get the Select Arrow.
- Hover over the text and Drag and a shadow will follow your mouse. Let go and the select text will be Moved to the new location. Drag means to click the left button on the mouse down, but not let go, and then move the mouse where you want to go.
- Use the Ctrl button while dragging the mouse and you will see a small plus sign added to the shadow. When you let go, Word will Duplicate the selection instead of moving it.

Navigating with the Scroll Bar

Scroll Bar
The scroll bar appears along the right side of the Word document.

- The first button on the scroll bar (scroll up/down) will help you split the window. Put your mouse over the button and drag it down as far as you would like, or double-click on the button to evenly split the window. To remove the split, drag the split bar to the top of the window, or double-click on the split.
- A split window allows you to have two horizontal screens for the same document. You may also want to try choosing “New Window” from the View tab, and then “Arrange All” to see the windows in vertical or horizontal.
- The second button of the scroll bar will show and hide the ruler ( ). The ruler can also be turned on/off from the View tab.
- The scroll arrows (scroll up/down) move the window in the direction you choose; however they do not move the cursor, only the screen view. Remember the keyboard stays active with the blinking cursor. If you scroll to an area you wish to type in, be sure to click on the screen to move the cursor.
- The scroll box (scroll up/down) gives an idea of where your current view is relative to the entire document. You can click above or below the box to move in that direction or you can drag the box to move through the document. Again this does not move the cursor, only the view.

Browse by Buttons
As mentioned above in the PageUp/PageDown section, the buttons at the bottom of the scroll bar are used to move between the pages, unless you have used the Find/Replace/Goto option, then the buttons will move between those options.

<table>
<thead>
<tr>
<th>goto</th>
<th>find</th>
<th>edits</th>
<th>heading</th>
<th>graphic</th>
<th>table</th>
</tr>
</thead>
<tbody>
<tr>
<td>field</td>
<td>endnote</td>
<td>footnote</td>
<td>comment</td>
<td>section</td>
<td>page</td>
</tr>
</tbody>
</table>

to reset to Browse by Page, click on the middle button and choose the blank sheet of paper.
**Zoom Slider**
- Under the browse by buttons is a Zoom Slider.
  - The plus will zoom in and make the document appear larger; the minus will zoom out and make the document appear smaller.
  - You can use the arrow in the middle of the zoom bar to make adjustments.
  - If you click on the percentage shown, Word will open the Zoom window. This can also be opened from the View tab.
  - The zoom can be set between 10% and 500%.

**Shortcut Keys**

**Cut, Copy and Paste**
These are among the most powerful Window’s shortcut keys.

<table>
<thead>
<tr>
<th>Ctrl X</th>
<th>Ctrl C</th>
<th>Ctrl V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Copy</td>
<td>Paste</td>
</tr>
<tr>
<td>X=&gt; Scissors</td>
<td>C=&gt; Copy</td>
<td>V=&gt; Editing Insert character</td>
</tr>
</tbody>
</table>

These characters are also right next to each other on your keyboard.

**File Management**

- Open Document..............Ctrl - O
- Close Document...............Ctrl - W or Ctrl - F4
- Save Document ..............Ctrl - S
- Print Preview/Print ........Ctrl - P
- Save As.........................F12

**Resizing**

- Increase Font Size ..........Shift - Ctrl - >
- Decrease Font Size .........Shift - Ctrl - <
- Increase Font Point ........Ctrl - [  
- Decrease Font Point.........Ctrl - ]
- Single Space .................Ctrl - 1
- Double Space ...............Ctrl - 2
- 1.5 Spacing .................Ctrl - 5

**Formatting Text**

- Bold ..........................Ctrl - B
- Italicize ........................Ctrl - I
- Underline ........................Ctrl - U
- Double Underline............Shift - Ctrl - D
- Subscript ......................Ctrl -=
- Superscript ......................Shift - Ctrl - =
- Small Caps .....................Shift - Ctrl - K
- All Caps.........................Shift - Ctrl - A
### Alphabetical List

<table>
<thead>
<tr>
<th>Ctrl Key</th>
<th>Command Description</th>
<th>Shift-Ctrl Key</th>
<th>Command Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl-A</td>
<td>Select All</td>
<td>Shift-Ctrl-A</td>
<td>All Caps</td>
</tr>
<tr>
<td>Ctrl-B</td>
<td>Bold</td>
<td>Shift-Ctrl-B</td>
<td>Bold</td>
</tr>
<tr>
<td>Ctrl-C</td>
<td>Copy</td>
<td>Shift-Ctrl-C</td>
<td>Copy Format</td>
</tr>
<tr>
<td>Ctrl-D</td>
<td>Font</td>
<td>Shift-Ctrl-D</td>
<td>Double Underline</td>
</tr>
<tr>
<td>Ctrl-E</td>
<td>Center</td>
<td>Shift-Ctrl-E</td>
<td>Track Changes</td>
</tr>
<tr>
<td>Ctrl-F</td>
<td>Open Navigation Pane</td>
<td>Shift-Ctrl-F</td>
<td>Font - Format Toolbar</td>
</tr>
<tr>
<td>Ctrl-G</td>
<td>Go to</td>
<td>Shift-Ctrl-G</td>
<td>Word Count</td>
</tr>
<tr>
<td>Ctrl-H</td>
<td>Replace</td>
<td>Shift-Ctrl-H</td>
<td>Set text Hidden</td>
</tr>
<tr>
<td>Ctrl-I</td>
<td>Italicize</td>
<td>Shift-Ctrl-I</td>
<td>Italicize</td>
</tr>
<tr>
<td>Ctrl-J</td>
<td>Full Justify/Left Align</td>
<td>Shift-Ctrl-J</td>
<td>Distribute letters evenly</td>
</tr>
<tr>
<td>Ctrl-K</td>
<td>Hyperlink</td>
<td>Shift-Ctrl-K</td>
<td>Small Caps</td>
</tr>
<tr>
<td>Ctrl-L</td>
<td>Left Align/Full Justify</td>
<td>Shift-Ctrl-L</td>
<td>Bullet</td>
</tr>
<tr>
<td>Ctrl-M</td>
<td>Increase Indent</td>
<td>Shift-Ctrl-M</td>
<td>Decrease Indent</td>
</tr>
<tr>
<td>Ctrl-N</td>
<td>New Document</td>
<td>Shift-Ctrl-N</td>
<td>Normal Style</td>
</tr>
<tr>
<td>Ctrl-O</td>
<td>Open Document</td>
<td>Shift-Ctrl-O</td>
<td>Open Research Pane</td>
</tr>
<tr>
<td>Ctrl-P</td>
<td>Backstage Print Options</td>
<td>Shift-Ctrl-P</td>
<td>Font Window</td>
</tr>
<tr>
<td>Ctrl-Q</td>
<td>Reset Paragraph</td>
<td>Shift-Ctrl-Q</td>
<td>Set font to “Symbol”</td>
</tr>
<tr>
<td>Ctrl-R</td>
<td>Right Align</td>
<td>Shift-Ctrl-S</td>
<td>Apply Styles</td>
</tr>
<tr>
<td>Ctrl-S</td>
<td>Save</td>
<td>Shift-Ctrl-S</td>
<td>Apply Styles</td>
</tr>
<tr>
<td>Ctrl-T</td>
<td>Increase Hanging Indent</td>
<td>Shift-Ctrl-T</td>
<td>Decrease Hanging Indent</td>
</tr>
<tr>
<td>Ctrl-U</td>
<td>Underline</td>
<td>Shift-Ctrl-U</td>
<td>Underline</td>
</tr>
<tr>
<td>Ctrl-V</td>
<td>Paste</td>
<td>Shift-Ctrl-V</td>
<td>Paste Format</td>
</tr>
<tr>
<td>Ctrl-W</td>
<td>Close Document</td>
<td>Shift-Ctrl-W</td>
<td>Word Underline (no spaces)</td>
</tr>
<tr>
<td>Ctrl-X</td>
<td>Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ctrl-Y</td>
<td>Redo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ctrl-Z</td>
<td>Undo</td>
<td>Shift-Ctrl-Z</td>
<td>Reset Character</td>
</tr>
</tbody>
</table>
Opening a File
The **Recent** option on the **File** tab shows a list of recently opened documents and file locations.

The pushpins shown after each file and location allow you to ‘pin’ the item to the **Recent** list. As you open more documents or search more locations the list will grow. The ‘pinned’ documents and locations will not be pushed off the list.

If the file you are looking for is not on the list you can choose **Open** from the **File** tab, or use the shortcut key, **Ctrl-O**.

The default file location is set in the Word options. You can change this under the **File** tab, **Options**, **Save**, **Default File Location**.

Once you can see the file you want to open, you can click once on the filename and click the **Open** button, or double-click on the filename.

Open Toolbar

1. These button help you navigate between the folders. The left arrow goes to the previous folder, the right arrow goes to the next folder and the drop down arrow offers a ‘history’ of all the locations you have looked at for this instance of the open window.

2. The second option is the location box, where the current list of files is located. The drop down list will offer a list of recently visited file locations.

3. The button at the end of the location box is a “refresh” button, it will search the location again.

4. This option allows you to search through the word documents within this file location.

5. The Organize menu offers choices such as **Copy**, **Paste**, **Undo**, and **Rename** to help with your document organization.

6. The **New Folder** button will create a folder within the current file location. You can name the folder, and move files into it by dragging them over the new folder.

7. This option allows you to change the way you are viewing the list of documents, including by icon, by list and by details.

8. This button turns the document preview pane on and off.

9. This button opens the Windows Help and Support window.
Saving
In order to keep a document you have created in Word, you need to save it. If you have already saved the file, such that it has a name and a location, the Save feature will keep any changes that made since the document was opened.

To save a file:
- From the File tab, choose Save
- Click on the Save button on the Quick Access Toolbar
- Use the shortcut key Ctrl-S.

Save As
If you want to save your file with a different name and/or location, click on the File tab, choose Save As... or press function key F12. If you have never saved this document before, any method you choose to save will activate the Save As dialog box.
- Word Document-Saves as a Word 2010 File
- Word 97-2003-Saves as an earlier version. This is important if you are working with people who are not using Office 2007.
- Other Formats-Open Save As window, choose other formats from the Save As type option.

The default file location is set in the Word Options. You can change this under the File tab, Options, Save, Default File Location.

The two most important things to remember with saving a file are:
1. Where is the file being saved?
2. What are you naming the file?
**Closing a Document**
To close a file, from the File tab choose Close, or use one of the shortcut keys (Ctrl-F4, or Ctrl-W).

You can also choose to exit Word; this option will close all the files. To exit, from the File tab choose Exit Word, or use the shortcut key (Alt-F4).

If you click the in the top right-hand corner of the window it will close the current document. If it is the only document open, the will exit Microsoft Word.

If there have been no changes to the document, Word will simply close the file, but if you have made modifications since the document was opened, created, or last saved, Word will prompt you to save.

- If you choose Save - Word will save the document with the same name into the same location it previously had. If this file has never been saved, Word will open the SaveAs window. (The key will push this button.)

- If you choose Don't Save - Word will close the window and you will lose any changes since the last time the document was saved.

- If you choose Cancel - Word will forget that you asked it to close the file and place you back in the document. (The Esc key will push this button.)

**Undo, Redo and Repeat**
Microsoft Word keeps track of most tasks you perform until you exit. Tasks such as formatting and deleting, can be undone. From the Quick Access Toolbar click the button ( ), or use the shortcut key Ctrl-Z.

Most windows programs have an Undo feature, many only allow you to undo one task. Word keeps track of each step that you have done since the document was opened.

There is a drop-down arrow next to the Undo button, on the standard toolbar. This allows you to see a list of every step you’ve done so far. If you want to undo something that you have done several steps ago, you have to undo every step between now and then. You cannot go back and undo a single task without undoing everything back to that point.

If you undo too far, or you change your mind about the undoing of that task, Word allows you to Redo. On the Quick Access Toolbar you will find the redo button ( ), or use the shortcut key Ctrl-Y.

If there is nothing to redo, Word puts a Repeat feature in Redo’s place ( ) and assigns the shortcut key (Ctrl-Y) to Repeat. For example if you type, “How now brown cow.” The repeat option will type it again and again for you.
**Cut, Copy and Paste**

Cut, Copy and Paste are clipboard features built into windows. The clipboard is a temporary storage location in windows where an item is stored for later recall. The windows clipboard can only store one item at a time. Microsoft Office 2007 has a Multi-Clipboard that can store 24 items. No matter how many items are in the Office clipboard, the Paste button and shortcut key (Ctrl-V) will only respond to the most recently copied item. The clipboard must be displayed to be able to use this feature. Items are stored with the copy and cut features, and recalled with the paste feature.

**Cut** will copy the selected text to the clipboard and remove it from the current location. This button appropriately shows a pair of scissors for the cut option. The shortcut key is Ctrl-X. To use the Cut command you need to first select the text or object you wish to move then choose the option. Move the cursor where you want the text or object to appear, and choose Paste.

- **Move**: Instead of Cut/Paste, try selecting the text, then click and dragging to a new location.

**Copy** will place the selected text on the clipboard; nothing will appear to happen on the window. The button shows two sheets of paper for the copy option. The shortcut key is Ctrl-C. To use the Copy command you need to first select the text or object, and then choose copy. Move the cursor where you want the text or object to appear, and choose Paste.

- **Duplicate**: Instead of Copy/Paste, try selecting the text, and then drag to a new location while holding down the Ctrl key. Be sure to let go of the mouse before you let go of the keyboard, and you will produce a duplicate.

**Paste** will produce the last option copied or cut to the clipboard. This button shows a sheet of paper coming from a clipboard for the paste option. The shortcut key is Ctrl-V, or Shift-Insert. You can usually paste the same item over and over again, until the computer has been restarted or you copy/cut something else.

- **Paste Special**: The drop down menu under the Paste button shows the Paste Special options. These options will change depending on what is currently in the clipboard. It can be a very useful tool to do things such as Paste as unformatted text. Unformatted text will get rid of hidden HTML codes from a webpage or the hidden formatting from another Word Document.

The **Format Painter** will copy the format of selected text and apply it to the text you specify. This button shows a paintbrush for the format painter option. To use the Format Painter command you need to first select the text that has the format you wish, click once on the button (a paintbrush will follow your mouse pointer), click on the text you want to reformat. This tool turns itself off after each use. To turn it on, and keep it on, double-click on the button on the standard toolbar. To turn it back off, simply click on that button again or press escape (Esc).

The **Clipboard** button will open the clipboard panel. When this panel is open, Word can remember up to 24 items. Click on the desired item in the list to paste it into your document.
**Format Font**
Most options to change the format of the text can be found on the **Home** tab, in the **Font** group.

1. **List of Fonts** - Changes the shape of the selected text.
2. **List of Font Sizes** - Changes the size of the selected text. You can type in your own custom size, the range is 1pt to 1638pt, including half sizes (e.g. 14.5pt) Use Ctrl-[ or Ctrl-] to increase and decrease by one font point.
3. **Grow Font** - Increases the size of the selected text, based on the list of font sizes. Use Ctrl-<> to increase the font based on the list of sizes.
4. **Shrink Font** - Decreases the size of the selected text, based on the list of font sizes. Use Ctrl-< to decrease the font based on the list of sizes.
5. **Change Case** - Changes the capitalization of your selected text. Choices include: Sentence case.; lowercase; UPPERCASE; Capitalize Each Word; and tOGGLE cASE.
6. **Clear Formatting** - Change the selected text to the default settings.
7. **Bold** - Changes selected text appear darker, like writing with a marker instead of a pen. Use Ctrl-B to bold.
8. **Italic** - Changes selected text to appear slanted, leaning the letters to the right. Use Ctrl-I to Italicize.
9. **Underline** - Changes selected text to have a single line under the text. The dropdown allows you to pick different underlines and underline colors. Use Ctrl-U for a basic underline.
10. **Strikethrough** - Changes the selected to have a single line through the middle of the letters.
11. **Subscript** - Changes the selected text to be small and lowered. Example: H₂O (“Subway goes down”). Use Ctrl-= to subscript.
12. **Superscript** - Changes the selected text to be small and raised. Example: x² (“Superman goes up”). Use Ctrl+- to superscript.
13. **Text Effects** - Changes the text to have more dramatic appearance. This option is only available in Office 2010.
14. **Text Highlight Color** - Changes the mouse to a highlighter. Turn on this tool and drag over text to highlight/un-highlight.
15. **Font Color** - Changes the selected text to the chosen color. When you choose a color it becomes the default. To see other color options, click **More Colors...** to see all the colors available.
Font Dialog Box
This window can be opened by clicking on the "more" button in the Font Group, by right-clicking on text and choose Font..., or by pressing Ctrl-D on the keyboard. The top half of the window shows the standard formatting options.

Font - Changes the shape of the selected text.

Font Style - Choose between bold and italic options to change the selected text.

Size - Changes the size of the selected text, type in any number between 1 and 1638; the larger the number, the larger the text.

Font color - Changes the color of the selected text. The more colors option is also available here.

Underline style - Places a custom underline on selected text

Underline color - Available only when there is an underline, changes the color of the chosen underline style.

Effects
Strikethrough: How now brown cow.
Double Strikethrough: How now brown cow.
Superscript: How now brown cow. (Shortcut key Shift-Ctrl=)
Subscript: How now brown cow. (Shortcut key Ctrl=)
Small caps: HOW NOW BROWN COW. (Shortcut key Shift-Ctrl-K)
All Caps: HOW NOW BROWN COW. (Shortcut key Shift-Ctrl-A)
Hidden: This option will “hide” the selected text, as if it were a tab or space character. The text will not show on the screen until you turn on the Show/Hide button \f (on Home Tab).

Set as Default...
You’ll find this option at the bottom of the window. Default formats are how all new documents will be set. This button allows you to set the default text formatting to your current choices. Word will give you a choice, to change the fonts for this document, or for all new documents created.
Text Effects...
New to Office 2010 is the ability to apply more dramatic text effects. These effects work best with larger fonts.

Text Fill
Text Outline
Outline Style
Shadow
Reflection
Glow/Soft Edges
3-D Format
**Advanced**

The **Advanced** tab of the Font window contains the Character Spacing.

**Scale:** This option will compress or stretch text horizontally, while keeping it its current height. This can range from 1% to 600%.

![Sample Text](200%)

200%  
100%  
50%  

**Spacing:** This option will expand or condense the spacing **between** characters. This can range from 0 to 1584.

![Sample Text](Expand by 1)

Expand by 1  
Normal  
Condensed by 1  

**Position:** This option will raise or lower the text relative to the baseline. This can range from 0 to 1584.

![Sample Text](Lowered by 3)

Lowered by 3  
Normal  
Raised by 3  

**Kerning for fonts:** This option automatically adjusts the amount of space between certain combinations of characters, so that the entire selection looks more evenly spaced. This option only works with TrueType or AdobeType manager fonts.

**OpenType Features**

Some fonts are created as OpenType fonts. The fonts in the Microsoft ClearType Collection - Calibri, Cambria, Candara, Consolas, Constantia, and Corbel are all considered OpenType fonts, that is their ligatures, number spacing options, number form options, and stylistic sets can be modified. Many of these changes are very subtle, but can be useful if you are trying to make your document look more professional for printing. Below are the different Stylistic Sets for the fonts Calibri and Gabriola.

<table>
<thead>
<tr>
<th>Font</th>
<th>Style 1</th>
<th>Style 2</th>
<th>Style 3</th>
<th>Style 4</th>
<th>Style 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibri</td>
<td>Quiet Mary</td>
<td>Quiet Mary</td>
<td>Quiet Mary</td>
<td>Quiet Mary</td>
<td>Quiet Mary</td>
</tr>
<tr>
<td>Gabriola</td>
<td>Quiet Mary</td>
<td>Quiet Mary</td>
<td>Quiet Mary</td>
<td>Quiet Mary</td>
<td>Quiet Mary</td>
</tr>
</tbody>
</table>
One of the most powerful tools in the Microsoft Suite is the Find and Replace Tool in Microsoft Word. The tools are listed in the **Editing** group on the **Home** tab. You can also use the keyboard shortcut Ctrl-F to Find and Ctrl-H to Replace.

When you click on Find, or press Ctrl-F, Word will open the Navigation pane on the right side of the window. When you type a word or phrase into the search box at the top of the pane, Microsoft Word will tell you how many matches it found, and give you a small preview of each match.

Within the document itself, Word will highlight the search values so you can see the match at a glance.

If you click on a match within the pane, Word will move the focus of the screen and keyboard to the chosen selection.

If you would like more search options, you can click the drop down arrow in the search box and choose Advanced Find. This option is also available from the Ribbon's **Find** button drop down.

The advanced Find window also contains the Replace and GoTo options.

The **More** button will expand the window to show you all the possible find/replace options available:
"More" Search Options
When you are finding or replacing there are several search options found under the More>> button.

You can change the direction you are searching with the Search: option. Your choices are Up (from the cursor to the beginning of the document), Down (from the cursor to the end of the document) and All (from the cursor through the end, through the top and back to the cursor).

If you choose a selection of text, Word will search the selection first and then ask if you would like the rest of the document checked.

You can tell Word to be sensitive to the capitalization of your text with Match case, and to search for words instead of fragments with the Find whole words only.

<table>
<thead>
<tr>
<th>FIND</th>
<th>SEARCH OPTION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Car</td>
<td>Match Case</td>
<td>Carefree Carly drives a car.</td>
</tr>
<tr>
<td>Car</td>
<td>Find whole words only</td>
<td>Carefree Carly drives a car.</td>
</tr>
</tbody>
</table>

Wildcards can be used when you want to be able to find different variations of a word. When the Use wildcards option is checked, you can use the question mark (?) to represent one character and the asterisk (*) to represent multiple characters.

<table>
<thead>
<tr>
<th>FIND (Use wildcards)</th>
<th>RESULTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>s?t</td>
<td>sat, set, sit</td>
</tr>
<tr>
<td>s*d</td>
<td>sad, stood, stand, sod</td>
</tr>
</tbody>
</table>

The Sounds like option will try to find words within your document that sound similar, but are not spelled the same as the word in your Find what: box.

<table>
<thead>
<tr>
<th>FIND (Sounds like)</th>
<th>RESULTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soul</td>
<td>Soul, Sole, Cell</td>
</tr>
</tbody>
</table>

The Find all word forms will attempt to find a word in all of its tenses and pluralities.

<table>
<thead>
<tr>
<th>FIND (Find all word forms)</th>
<th>RESULTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>shop</td>
<td>shop, shops, shopping, shopped</td>
</tr>
<tr>
<td>sit</td>
<td>sit, sat, sits, sitting</td>
</tr>
<tr>
<td>goose</td>
<td>goose, geese</td>
</tr>
</tbody>
</table>
The **Match prefix** will attempt to find words that begin with your find option. The **Match suffix** will attempt to find words that end with your find option.

<table>
<thead>
<tr>
<th>FIND</th>
<th>SEARCH OPTION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ter</td>
<td>Match prefix</td>
<td>Terrace, Terrific, Terrier</td>
</tr>
<tr>
<td>Ter</td>
<td>Match suffix</td>
<td>Computer, laughter, halter</td>
</tr>
</tbody>
</table>

The last two options allow Word to **ignore punctuation characters** such as periods and commas, and **ignore white space characters** such as line breaks, tabs and spaces.

**Replacing Formats**

Microsoft Word allows you to find and replace different formats throughout your document. For example I can find all the instances of the word "green" and replace them with a green colored font.

![Format options in Find and Replace dialog box](image)

You can use the **Format** button at the bottom of the Find and Replace window to be able to find and/or replace Font, Paragraph, Tab, language, Frame, Styles and Highlighting formats.

One option you can do is simply find a particular format and replace with another format (in this example changing all the red fonts to green fonts):

![Find and Replace dialog box with Format options](image)

If you replace all, Word will find all text colored red and change the color to blue, no matter what the text or other formats might be. There is a **No Formatting** button in the **More** section that allows you to clear any formatting options you have set.
**Special Characters**

There are many special characters within Microsoft Word. Some of these can be searched and changed for others in our Find and Replace window. Below is a list of special characters that can be used. You can type in the character or choose them from the **Special** button.

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>^p</td>
<td>Paragraph Mark</td>
</tr>
<tr>
<td>^t</td>
<td>Tab Character</td>
</tr>
<tr>
<td>^?</td>
<td>Any Character</td>
</tr>
<tr>
<td>^#</td>
<td>Any Digit</td>
</tr>
<tr>
<td>^$</td>
<td>Any Letter</td>
</tr>
<tr>
<td>^^</td>
<td>Caret Character</td>
</tr>
<tr>
<td>^%</td>
<td>Section Character</td>
</tr>
<tr>
<td>^v</td>
<td>Paragraph Character</td>
</tr>
<tr>
<td>^n</td>
<td>Column Break</td>
</tr>
<tr>
<td>^+</td>
<td>Em Dash</td>
</tr>
<tr>
<td>^=</td>
<td>En Dash</td>
</tr>
<tr>
<td>^e</td>
<td>Endnote Mark</td>
</tr>
<tr>
<td>^d</td>
<td>Field</td>
</tr>
<tr>
<td>^f</td>
<td>Footnote Mark</td>
</tr>
<tr>
<td>^g</td>
<td>Graphic</td>
</tr>
<tr>
<td>^l</td>
<td>Manual Line Break</td>
</tr>
<tr>
<td>^m</td>
<td>Manual Page Break</td>
</tr>
<tr>
<td>^~</td>
<td>Non-breaking Hyphen</td>
</tr>
<tr>
<td>^s</td>
<td>Non-breaking Space</td>
</tr>
<tr>
<td>^-</td>
<td>Optional Hyphen</td>
</tr>
<tr>
<td>^b</td>
<td>Section Break</td>
</tr>
<tr>
<td>^w</td>
<td>White Space</td>
</tr>
</tbody>
</table>
Class Exercise
- Open Word
- Explore the Window
  - Quick Access toolbar
  - Ribbon
  - Ruler
  - Zoom scroll bar
  - View Shortcuts (ribbon View Tab)
  - Set Zoom to Page Width
  - Customize Status Bar
- Enter Text: How Now Brown Cow?
  - Right-click, Center
  - Return to Home Tab, Uncenter (or left align)
- Arrow Keys
  - Use the arrow keys to go back and forth between the letters.
  - Use the control and arrow keys to go back and forth between words
  - Use the shift and the arrow keys to select letters
    - Shift Ctrl Arrows to select words
  - Use home key to go to the beginning of the line, and end key to go to the end of the line
- Go to the beginning of the line (HOME)
  - Hold down the shift key and press END
- Notice the mysterious end bit (End of Document marker)
  - Turn on Show Hide (paragraph group) to see the symbol. Turn it back off.
  - Select text from left to right including extra character
    - Home, then Shift-End
  - Cut and then paste 10 times...
- Click on dropdown next to Undo button, go back to the CUT
  - Select text from left to right (without EOD)
    - Home, then Shift-End, then Shift-Left
  - Copy and paste down to 3 inches
- Separate the document into three paragraphs
  - About 1" down, half way through, press Enter. Repeat.

- Arrow Keys
  - Use the arrow keys to go up and down between the lines
  - Use the control and arrow keys to go up and down between paragraphs
  - Use the shift and the arrow keys to select paragraphs
  - Use Ctrl home and Ctrl End key to go to the beginning and end of the document

- Mouse Inside Paragraph
  - Click - moves cursor
  - Double-click - selects Word
  - Triple-click - selects Paragraph

- Mouse from left margin
  - Click - Selects Line
  - Double-click - selects Paragraph
  - Triple-click - selects document (same as Ctrl-A)

- Mouse with Shift and Ctrl
  - Click inside a paragraph, Shift-Click inside another to select everything in between
  - Click inside a paragraph, Ctrl-Click on a word to select the sentence
    - Once a selection is made, selecting with the ctrl key down adds to the selection

- Cut/Copy vs. Move/Duplicate
  - Select first sentence and turn it red
  - Hover over the selected sentence and drag it to the end of the first paragraph
  - Try again with the Ctrl key to Duplicate.

- Format Fonts (See Page 10)
  - Select the first sentence and change the font
  - Change the size
    - Change size box (14, 15, 15.5, 0)
    - Try Increase/Decrease font size buttons
    - Try keyboard shortcuts Ctrl < and Ctrl >
    - Try keyboard shortcuts Ctrl [ and Ctrl ]
- Format Fonts (continued - See Page 10)
  o Change Case to Proper Title Case
  o Bold (Ctrl B), Italicize (Ctrl I), Underline (Ctrl U)
    ▪ Customize the underline to be a different shape and color
  o Superscript, Subscript
  o Change the color
  o Select All (Ctrl-A) and Clear Formats (button above font color)

- Select the first sentence
  o Open More Fonts
    ▪ Format: Comic Sans, Bold, Size 14, Green
    ▪ Format: Green, Fancy underline, Red Underline color
- Use format painter to format throughout the document (page 9)
  o Esc to turn off tool

- Select all
  o Clear Formatting
  o Delete

- Paste (How now brown cow?)
  o Select sentence, including End of Document character
  o Cut
  o Paste about 10 sentences
- Select All
  o Use "Style" -> No Spacing

- Select the first Sentence
  o Change Font Size to 24
  o Change the Text Effects (Fuzzy A)
    ▪ Modify some of the settings
  o Delete
- Select a sentence
- Open "More" Formatting Fonts
- Go to the second page of the window, Advanced
- Change each line to a different setting
  - Set scale to 200
  - Set spacing to Expanded by 1
    - Change to Expanded by 0.3pt
  - Set spacing to condensed by 1
    - Change to Expanded by 0.3pt
  - Select a word, change the position to raised
    - Try another word for lowered

- Go to the Undo button's drop down list
  - Choose Clear (above "Clear all formatting")
  - This should bring back the three paragraphs
  - If you undo too far, use the redo button (page 8)

- Find/Replace
  - Open the Find pane
    - Find cow
  - Open Replace
    - Find cow, replace with cow
      - Replace All
    - Find brown
      - Open the More button
      - Replace with brown
        - Format Font to be brown and bold
        - Replace All
  - Find ? <space>, replace with ?<paragraph mark>
    - Space can be typed in from the keyboard
    - Paragraph mark can be inserted through the Special button
    - Replace All